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1 Introduction

1.1 RF-PIPING and RF-PIPING Design Add-OnModules

Pipelines are used to transport fluids. They are used in all areas of construction. For the design and
calculation of pipelines, the twoUS standards ASME B31.1 [1] andASMEB31.3 [2] are ground-break-
ing. DIN EN 13480-3 [3] contains the appropriate guidelines for metallic industrial piping.

With the RF-PIPING add-on module, DLUBAL offers a powerful tool for modeling piping systems.
There is no need to adjust to a new interface because the add-on module is displayed as an
extension in the RFEM user interface when modeling pipelines.

You can model the pipelines like members in the RFEM user interface. It is possible to graphically
enter connections such as tees and piping components using corresponding dialogs. Helpful
libraries for pipelines, flanges and other components are included in the program.

You can enter loads and combine load cases using the usual procedures. You can decide if the
load cases should be automatically or manually superimposed.

The calculation of internal forces, deformations and support forces corresponds to the general
principle of RFEM. You can use the graphical RFEM user interface with all functions to evaluate the
results.

With the secondmodule, RF-PIPING Design, you can carry out piping analysis according to the
previously defined standard ([1], [2] or [3] - in preparation). In the current state of development of
the module, stress designs are carried out due to permanent, occasional or accidental loads.

You can clearly document all data, frommodeling to design, in the global printout report of RFEM.

We hope you will enjoy working with RF-PIPING and RF-PIPING Design.

Your DLUBALTeam

1.2 Using theManual

Since the topics installation, graphical user interface, results evaluation and printout are described
in detail in the RFEMmanual, no further description is given here. The present manual focuses on
typical features of RF-PIPING and RF-PIPING Design.

The descriptions in this manual follow the sequence and structure of themodule's input and result
tables. In the text, the described buttons are given in square brackets, for example [Preset all
members]. They are also displayed on the left. The expressions that appear in dialog boxes, tables,
and menus are set in italics to clarify the explanations.

At the end of the manual, you find the index. In addition, feel free to use the search function on
our blog website www.dlubal.com/blog/en where you can find tips and tricks in our articles about
the add-on modules RF-PIPING.
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2 RF-PIPING
In this chapter, you will find information about the different dialog boxes and functions of the
add-on module RF-PIPING.

2.1 Opening RF-PIPING

RF-PIPING is an extension of RFEM. The functions of the piping module are available when Piping
analysis in the General Data dialog box, Options tab is activated.

Figure 2.1: Dialog box NewModel - General Data, Options tab

Data Navigator

After closing the dialog box, additional navigator items and tables as well as a new toolbar are
available. They are described in Chapter 2.1.2.

Figure 2.2: Toolbar Piping
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2.1.1 Piping Analysis - Settings

To get to the detail settings for RF-PIPING, use the [Edit] button (see Figure 2.1). A dialog box
appears with important settings for the piping analysis.

Figure 2.3: Dialog box Piping Analysis - Settings

Stress Intensification Factors (SIFs) and Flexibility Factors
The following standards are available in the list Piping Standard:

• ASME B31.1-2012 [1]

• ASME B31.3-2012 [2]

• EN 13480-3:2013 [3] (in preparation)

The option Use in-plane/out-of-plane SIFs is intended to be used for an analysis according to [3].

For a correct analysis in the module RF-PIPING Design, detailed data on the design of the tee is
necessary. The list Default branch connection type contains the following options:

• Welding forged tee

• Reinforced fabricated tee with pad or saddle

• Unreinforced fabricated tee

• Extruded welding tee

• Welded-in contour insert

• Branch welded-on fitting (integrally reinforced)

• User-defined
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The check box B31.1/B31.3Welding/Contour Tees meet ASME B16.9 determines if the para-
meters rx and Tc are available for the branch connection typesWelding forged tee andWelded-in
contour insert (see Chapter 2.2.10, page 27). This option thus refers to the note (7) in [1] Table D-1
and Note (8) in [2] Table D300.

Generated Combinations
This dialog section manages how the load cases are combined.

Create Combinations Automatically

The superposition of load cases is carried out in piping combinations. If the check box is selected,
these combinations are generated automatically. You can define other combinations individually
here.

If the check box Hydrotest is selected, additional piping combinations for the hydrostatic test
pressure are generated.

Expansion Combinations

The temperature combinations can be generated according to the following two methods:

• Difference between operating and sustained combination (result combinations)

• Solve independently (piping load combinations)

In the first case, result combinations are generated. The second case generates load combinations.
The difference between the two possible combinations is described in the RFEMmanual, Chapter
5.5 and 5.6.

It is generally recommended to use result combinations: Here, the thermal load cases are entered
separately which interact with the other loads.

Internal Pressure
An internal pressure results in elongation and straightening of pipes. The check boxDisplacements
due to pressure (Bourdon effect) and the two radio buttons below specify if and how this effect is
considered.

Furthermore, if the Bourdon effect is considered, you have to specify if the internal pressure acts
as expansion load or as sustained load.

Material Properties
This check box specifies if the temperature dependent material properties are used which are
stored in the library (see Chapter 2.2.1.3, page 13). If the standard setting is deactivated, those
values will be used which correspond to the reference temperature Tref indicated in Table 7.1 -
Materials.



2 RF-PIPING

©DLUBAL SOFTWARE 2016

7

2
2.1.2 Extension for Toolbars, Navigator and Tables

RF-PIPING is displayed in the RFEM user interface as an extension in the toolbars, navigator and
tables.

Toolbar
By activating themodule RF-PIPING, the corresponding toolbar is displayed (see Figure 2.2, page 4).
The functions contained therein enable the modeling of the pipeline.

Button Description

New Pipeline

New Reducer

New Valve

New 3-way Valve

New 4-way Valve

New Bend

New Flange

New Blind Flange

New Tee

New Branch Connection - Factors

Table 2.1: Buttons of RF-PIPING

The buttons and the corresponding dialog boxes are described in Chapter 2.2.

Navigator
In the navigator, the category Load Cases and Combinations is extended by the entry Piping Load
Combinations.

Moreover, the new category Piping (RF-PIPING) is added. All data concerningmaterials, cross-sec-
tions and pipelines are saved here.

Figure 2.4: Data Navigator for RF-PIPING
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Tables
All information about the pipelines are saved in the tables 7.1 to 7.10. To open these tables, use
the button shown on the left.

Figure 2.5: Tables 7.xx for RF-PIPING

The functioning of these tables is described in the RFEMmanual, Chapter 11.5.

2.2 Dialog Boxes of RF-PIPING

2.2.1 Pipeline

A pipeline is a continuous string of members of the type piping. By clicking the button [New
Pipeline], you can model new member strings. A dialog box appears where you can provide
detailed information about the pipeline.

Figure 2.6: Dialog box New Pipeline
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No.
You can assign any number. It is not possible to modify it afterwards.

Pipeline Description
You can enter any description for the pipeline.

Member No.
This number defines the firstmember of the new pipeline. You can freely define it. Othermembers
of the same pipeline will have sequential numbers.

Cross-Section

You have to define the cross-section of the pipeline in the text box. By using the button , you
can select a cross-section from the pipeline library (see Chapter 2.2.1.2, page 11).

For general information about the cross-sections, have a look at the RFEMmanual, Chapter 4.13.

Bend
In this dialog section, you can define if the bends are generated automatically during the following
modeling and which bend radius is considered.

Bend Factors
The values of the Flexibility factor as well as of the Stress intensification factors indicated in this
dialog section are automatically calculated. However, it is also possible to define themmanually.

The flexiblity factor k has an influence on the bending stiffness of the pipe bend. The stress
intensification factors i only take effect at the piping design with RF-PIPING Design.

2.2.1.1 Defining Pipelines

If you have entered all data, you can close the dialog box by clicking [OK]. You can now define the
pipeline as polyline in the work window. The following dialog box appears:

Figure 2.7: Dialog box New Pipeline

In the New Pipeline dialog box, the numbers of the newmembers, lines and nodes are preset, but
it is possible to modify them.
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For entering the coordinates, you have the following three options:

• Current CS: The coordinates always refer to the origin of the coordinate system. The grid is
fixed.

• Grid origin: The coordinates refer to the origin of the grid.

• Last node: The coordinates always refer to the last defined node. The position of the grid
origin is also in the last node.

The Bend dialog section controls if bends are generated when gradually defining the polyline and
which form they have. The parameters are explained on the previous page.

If you select the check box Step, the length of the pipeline L is displayed at the cursor which may
help to model the pipeline easier.

Buttons
Two buttons in this dialog box are useful for modeling.

Details

Figure 2.8: Dialog box New Pipeline - Details

Set Coordinates in Table: The input data is saved in the RFEM Table 1.1 Nodes. It is possible to save
the nodes in the global coordinate system or with reference to another node.

Auto Connect: This check box controls if a connection is generated between two pipelines, when,
for example, the endpoint is placedonanexistingpipeline. If this checkbox is selected, the existing
pipeline in this node is separated; both pipelines are connected. If this option is deactivated, the
existing pipeline will not be separated. Depending onwhether the optionUse division formembers
with nodes lying on them is activated in the FEMesh Settings dialog box, the two pipelines are either
connected or not.

Rotation: This option may be helpful for bends which look drilled in the rendering. The drilling is
caused by a change of the local z-axis direction.

Undo

Modeling a pipeline is equal to modeling a continuous line. From the very start to the very end,
all parts are continuously placed. If you have made any mistakes, you can undo your entries
step-by-step by using this button without deleting the pipe.
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2.2.1.2 New Piping Cross-Section

In the dialog box New Piping, you have to define a cross-section (see Figure 2.6, page 8). You can
use the button .

The cross-section library is displayed where you can select the piping cross-section. This dialog
box is described in the RFEMmanual, Chapter 4.13.

Figure 2.9: Dialog box Rolled Cross-Sections - Pipes for Piping - Straight Pipe

After clicking [OK], the New Piping Cross-Section dialog box is displayed (see Figure 2.10). In this
dialog box, you can provide specific information about the cross-section, the bend, the structure
of the pipeline and the stress analysis.

In this dialog box, you can enter specifications separately for straight sections and bends of a
pipeline.
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Straight Pipe

Figure 2.10: Dialog box New Piping Cross-Section

In the first tab, you can provide information about the cross-section of straight sections. You can
select between a Standard section from the library or a Parametric section defined by outside and
inside diameter with corresponding wall thickness.

You can select theMaterial of the cross-section from the list of already defined materials. With the
buttons below the list, you can open the material library as well as create or edit a material. For
more information about the material library, have a look at Chapter 2.2.1.3, page 13 and at the
RFEMmanual, Chapter 4.3.

The LineMass is automatically calculated by default from the cross-section and the material. How-
ever, you can define it manually.

In the dialog section below, the Total LineMass of the straight pipe sections and bends is displayed.
It contains additional masses from the Layers tab.

In the last dialog section, you can define the Design pressure PC and the Design temperature TC.

If you use piping components such as flanges, the list of possibilities will be reduced automatically
according to the design pressure to appropriate elements.

Bend
The setting options of this tab apply solely to bends of pipelines. The concept corresponds to the
one for pipes (see above).
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Layers

Figure 2.11: Tab Layers

In this tab, you can provide further information on the structure of the pipe. You can define the
thickness of the layer as well as the specific weight each for Insulation, Plating and Lining.

If you enter the LineMassmanually, the values of the last calculated line masses are available so
that individual values for pipe and bend can be entered.

2.2.1.3 Material Library

RFEMmanages the materials for RF-PIPING separately in the category Piping (RF-PIPING). You can
access the material library as usual by using the navigator shortcut menu or the button in Table
7.1 Materials, Column A.

Figure 2.12: Shortcut menuMaterials

In the library, the materials for the pipelines are preset by the Filter function.
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Figure 2.13: Dialog boxMaterial Library

The characteristic features of pipeline materials are the temperature dependent strengths which
are specified in theMaterial Properties dialog section.

Chapter 4.3 of the RFEMmanual describes how to select, modify or add materials in the library.
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2.2.2 Reducer

Reducers are used to modify the piping cross-section. When clicking the [New Reducer] button,
you can select the member in the work window where you want to apply the reducer.

Reducers refer to nodes. If a cross-section is modified within a member, you have to divide this
member in advance at the appropriate position.

Figure 2.14: Select member in the work window

When clicking on the member, the New Reducer dialog box appears.

Figure 2.15: Dialog box New Reducer

Reducer Type
If the reducer is specified as User-defined, the geometry of the reducer can be defined manually in
the other dialog sections.

With the button , you can access a library with standardized reducers (see Figure 2.16).

If you have already defined a cross-section for the Reducer end (dialog section below), solutions
combatible with DN are preset in the library.
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Figure 2.16: Reducer library

Cross-Section
A reducer is – similar to a taper – defined by a start and end cross-section. Depending on which
node of the member was selected in the Dimension Change dialog section, either the Reducer start
or the Reducer end can be changed.

Geometry
If you have manually defined the reducer, you have to specify the start point (x-location along the
member axis) as well as the length of the reducer in addition to the cross-sections. You can also
define it graphically with and .

The Cone semi-angle can be specified as user-defined if necessary.

Dimension Change
The node specified here defines which end of the pipe is concerned by the modification of the
cross-section.

Eccentricity
Pipes always refer to the cross-section's centroid (wireframemodel). For reducers, this leads to the
fact that the pipe is continued centrally with a smaller cross-section perimeter. If, for example, the
bottom side of the pipe has to be continuous, you can define an Axial offset of the local member
axes after having selected the check box Eccentricity.

Reducer Factors
You can manually define the Flexibility factor and the Stress intensification factorwhere necessary.
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2.2.3 Valve

The definition of a valve is used within the program to correctly enter the weight and the stiffness.
When clicking on the [New Valve] button, you can select the member where you want to apply
the valve.

Valves refer to members. Therefore, they can be arranged within a member.

Figure 2.17: Select member in the work window

When clicking on the member, the New Valve dialog box appears.

Figure 2.18: Dialog box New Valve

Valve Type
Currently, there are no preset valves available.

Cross-Section
The cross-section of the member is displayed for information purposes.

Geometry
To place the valve at the member, you have to define the Start (x-location along the member
axis) and Length of the valve (end point). By using and , you can graphically define both
positions.



2 RF-PIPING

©DLUBAL SOFTWARE 2016

18

2
Parameters
In this dialog section, you can find options to adjust theMass of valve and insulation as well as
setting options concerning the stiffness. The mass is uniformly “distributed” over the length of
the valve.

Flanges

Figure 2.19: Dialog box New Valve, tab Flanges

Use the second tab of the dialog box to assign flanges on both sides of the valve. By using this
function, you can correctly determine the load situation. The [Library] helps to find the correct
flange type and thus the correct load (see Figure 2.20).

As an alternative, you can manually define the flanges withMass and the Nominal Pressure.

If you want to use the same flange type at both ends, you can transfer the flange with the button
to the other part.
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Figure 2.20: Flange library

Additional Mass

Figure 2.21: Dialog box New Valve, tab Additional Mass

To consider the eccentric mass of the handwheel, you can define theMass and the Offset in this
tab from the center of the pipe.
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2.2.4 3-Way Valve

You can arrange 3-way valves on nodes where three pipes are connected. When clicking on the
button [New 3-way Valve], you can select the corresponding node.

Figure 2.22: Select node in the work window

When clicking on the node, the New 3-way valve dialog box appears.

Figure 2.23: Dialog box New 3-way Valve

Valve Type
Currently, there are no preset 3-way valves available.

Valve Segments

In this dialog section, you have to define the Length of the individual segments. By using and
, you can also graphically define them.

The Parameters dialog section and the other tabs Flanges and Additional Mass are described in
Chapter 2.2.3.



2 RF-PIPING

©DLUBAL SOFTWARE 2016

21

2
2.2.5 4-Way Valve

You can arrange 4-way valves on nodes where four pipes are connected. When clicking on the
button [New 4-way Valve], you can select the corresponding node.

Figure 2.24: Dialog box New 4-way Valve

Currently, there are no preset 4-way valves available.

The sections of this dialog box are described in Chapter 2.2.3 and Chapter 2.2.4.



2 RF-PIPING

©DLUBAL SOFTWARE 2016

22

2
2.2.6 Bend

If the check box for generating bends is selected in the New Pipeline dialog box (see Figure 2.6,
page 8), bends are generated automatically between straight pipeline sections when defining a
pipeline. By using the [New Bend] button, you can subsequently define a bend to connect two
straight pipeline sections.

When clicking on the corresponding node, the New Bend dialog box appears.

Figure 2.25: Dialog box New bend

In the first tab, you define the cross-section as well as the member number of the bend.

The Bend and Bending Factors dialog sections are explained in Chapter 2.2.1, the Flanges tab in
Chapter 2.2.3.

The Bend Angle is displayed for information purposes.



2 RF-PIPING

©DLUBAL SOFTWARE 2016

23

2
2.2.7 Flange

For detailed views of the loading, you can define flanges. When clicking on the [New Flange]
button, you can select the node or member in the work window where you want to apply the
flange.

Figure 2.26: Select member in the work window

When clicking on the node or member, the New Flange dialog box appears.

Figure 2.27: Dialog box New Flange

Flange Type
If the flange is specified as User-defined, the parameters of the reducer can be defined manually in
the other sections.

With the button , you can access a library with standardized flanges (see Figure 2.19, page 18).
Here are solutions preset which are suitable for the cross-section. In the library, you can filter
according to DN and PN compatible entries.

Cross-Section
The current piping cross-section is displayed here for information purposes.

Geometry
If you havemanually defined the flange, you have to specify the Start (x-location along themember
axis) as well as the Length of the flange. You can also define it graphically with .

When you use flanges from the library, you just have to indicate the position of the flange.
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2.2.8 Blind Flange

Blind flanges are used to lock nozzles and piping ends. When clicking on the button [New Blind
Flange], you can select the corresponding node in the work window.

When clicking on the node, the New Blind Flange dialog box appears.

Figure 2.28: Dialog box New Blind Flange

Flange Type
If the flange is specified as User-defined, the parameters can be defined manually in the dialog
section below.

With the button , you can access a library with standardized blind flanges (see Figure 2.29).
Here are preset solutions which are suitable for the cross-section. In the library, you can filter
according to DN and PN compatible entries.

Figure 2.29: Blind flange library
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Cross-Section
The current piping cross-section is displayed here for information purposes.

Flange Parameters
If you have selected the blind flange from the library,Mass and Nominal Pressure are preset. The
pressure classes refer to the design pressure which you can define in the piping cross-section.

If the blind flange is specified as User-defined, both parameters can be defined manually. Only the
mass is considered as an additional load for the calculation.

2.2.9 Tee

If a pipe is connected to an existing pipeline, prefabricated tees can be used for connection. When
clicking on the [New Tee] button, you can select the corresponding node in the work window.

Only nodes are allowed where two pipes go straight through. The third pipe can be connected in
any way.

Figure 2.30: Select node in the work window

When clicking on the node, the New Tee dialog box appears.

Figure 2.31: Dialog box New Tee

Tee Type
If the tee is specified asUser-defined, the parameters can be definedmanually in the dialog sections
below.

With the button , you can access a library with standardized tees (see Figure 2.32). Here are
preset solutions which are suitable for the connection. In the library, you can filter according to
DN compatible entries.
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Figure 2.32: Tee Library according to EN 10253-2 [4]

Cross-Section
If the tee is specified as user-defined, you can define the cross-sections for the Run and the Branch.

Geometry
If you select the tee from the library, the geometry parameters of the connection will be entered
automatically. If you manually enter the data, you have to define the Length and inner Wall
thickness for the run and the branch. You can define the lengths also graphically by using the
buttons and .

Other Parameters
TheMass of the tee is uniformly distributed as a distributed load over the parts of the tee. Only
the corresponding pipe weight is considered for the value 0.

Flanges
In the second tab of the dialog box, you have the possibility to arrange flanges on the connection.
The functions of this tab are described in Chapter 2.2.3 on page 18.
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2.2.10 Branch Connection

The stress intensification factors (SIF) relevant for the design differ according to the type of tee.
The type preset in the basic settings is used by default (see Chapter 2.2.9). You canmanually define
the factors for each connection by using the [New Branch Connection] button.

When clicking on the corresponding node, theNewBranchConnection - Factors dialog box appears.

Figure 2.33: Dialog box New Branch Connection - Factors

Tee Type
This list contains different types of tees according to [1] (see also Chapter 2.1.1, page 5). Depending
on the selection, more information about, for example, diameters or wall thicknesses is necessary.

Figure 2.34: Tee Types

With the option User-defined, you can manually define the flexibility and stress intensification
factors.
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2.3 Load Cases and Combinations

The loads acting in the piping structure are organized in different load cases. It is possible to
superimpose these load cases – manually or automatically – in Piping Load Combinations (PC)
and in Result Combinations (RC).

The functionality of these two combination possibilities is similar to the load and result combina-
tions in RFEM. They are described in the RFEMmanual, Chapter 5. Only the specific characteristics
of piping construction will be mentioned in the following.

2.3.1 Load Cases

Load cases enable sorting of loads according to their action category. By activating RF-PIPING in
the General Data dialog box, the list of possible action categories is extendend.

Figure 2.35: Action categories for piping load cases (in green)

The action categories for the classification of piping loads are:

• Pipe self-weight
• Fluid
• Fluid - Pressure Test
• Temperature
• Pressure
• Test pressure
• Displacement
• Hanger
• Cold spring

A load case which is adequate for piping design has to be classified in one of the piping-specific
action categories. These categories are described, for example, in [3] Section 4.2.5 as design
conditions.

If the load combinations are generated automatically according to the default settings in the
Settings dialog box (see Figure 2.3, page 5), only those load cases which have been classified as
piping load cases are considered for creating piping combinations and result combinations. Load
cases of other action categories are ignored.
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2.3.2 Piping Load Combinations (PC)

The superposition of load cases is normally carried out in Piping load combinations. They are based
on the principle of the load combinations: The loading of the single load cases is combined to a
“big load case” according to the combination criterion.

Figure 2.36: Dialog box Edit Load Cases and Combinations, tab Piping Load Combinations

Depending on the load situation, you may have to generate different combinations of the load
cases. They are classified in Stress Types. If you manually define a combination, you have the
following options:

Figure 2.37: Stress types

Later onduring the design in themodule RF-PIPINGDesign, the stress type of a piping combination
determines which analysis is carried out with the resulting internal forces. If you manually define
combinations, you have to take care that they are correctly allocated.

If combinations are created automatically (see Settings dialog box, Figure 2.3, page 5), the piping
load combinations are automatically allocated to the corresponding stress types.

If there are more relevant temperature/pressure load cases , the pairs have to be defined appropri-
ately before the combination. An appropriate message will be displayed before the combination.
However, it is also possible to assign it later by using the button at the botton in the Edit Load
Cases and Combinations dialog box. The Grouping of Thermal and Internal Pressure Load Cases for
Operating Combinations dialog box will be displayed (see Figure 2.38).
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Figure 2.38: Dialog box Grouping of Thermal and Internal Pressure Load Cases for Operating Combinations

2.3.3 Result Combinations (RC)

The function of result combinations is described in the RFEMmanual, Chapter 5.6.

Result combinations are used in piping construction to generate temperature combinations. If you
have selected the automatic generation of combinations in the Settings dialog box (see Figure 2.3,
page 5), the combinations of the stress type Expansion will be created as a result combination.
The internal forces result from the difference between the operating stress piping combinations
(OPE) and the sustained piping combinations (SUS).

Figure 2.39: Dialog box Edit Load Cases and Combinations, tab Result Combinations

If the option Solve independently (piping load combinations) in the Settings dialog box (see Fig-
ure 2.3, page 5) is selected, no result combinations will be generated. The situations Expansion
are represented in this case by piping combinations.
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2.4 Piping Loads

The loading of the pipeline can be carried out with nodal and member loads.

For member loads, you can also select piping-specific load types such as Pipe content - full/partial
and Pipe internal pressure in addition to temperature loads.

Figure 2.40: Dialog box NewMember Loadwith options for piping loads

The piping-specific load types are briefly described in the following table:

Load Type Description

Temperature
Temperature load evenly distributed over the member cross-section.
You have to define the heating Tc with reference to the member
center line.

Pipe content - full
Distributed load due to complete filling of a pipe. You have to define
the specific weight 𝛾 of the pipe content.

Pipe content - partial
Distributed load due to partial filling of a pipe. In addition to the
specific weight 𝛾 of the pipe content, you have to define the filling
level d.

Pipe internal pressure
Constant internal pressure of a pipe. You have to define the value of
the internal pressure.

Table 2.2: Specific load types for pipelines

The definition of node and member loads is described in the RFEMmanual, Chapter 6.1 and 6.2.
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2.5 Selection andModification of Pipelines

Before you can edit pipes or pipelines, you have to select the relevant objects. You have different
options:

• Selection in the work window by clicking the object

• Selection in the Data Navigator by clicking the entry

• Selection in the table by clicking the line

The selection of pipelines in the work window is similar to the selection of members: Left-click to
select the object, double-click to open the editing dialog box of the pipe or a component (pipe,
bend, reducer, etc.).

When you right-click the object, a shortcut menu is displayed where you have different editing
options.

Figure 2.41: Piping shortcut menu with editing options (highlighted)

Edit Pipe

This option is the same as double-clicking the object. The dialog box is displayed and you can edit
the pipe (or the valves, flanges, etc.).

Edit Pipeline Part

With this function, the whole pipeline can be edited. In the Edit Pipeline Part ... dialog box (see
Figure 2.42), you can define, for example, a new bend radius for all bends or a new cross-section
for the pipeline.
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Figure 2.42: Dialog box Edit Pipeline Part 1/2

Edit Pipeline

With this function, you can edit the description of the pipeline and change themembers which
display the pipeline. Thus, you can add members at a later time.

Figure 2.43: Dialog box Edit Pipeline

Delete Piping

The selected pipeline or the selected object will be deleted.
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Compose Pipeline

If connected piping elements (members of the member type Piping) are present, which have not
been assigned to any pipeline, you can define a new pipeline with this function.

Figure 2.44: Dialog box Compose Pipeline

Join Pipelines

With this function, you can connect multiple pipelines. However, they have to match the criteria
of a continuous member, i.e. the members of each pipeline must not branch.

Figure 2.45: Dialog box Join Pipelines

Explode Pipeline

The selected pipeline is divided in its single elements. Afterwards, you can rearrange these ele-
ments.

Pipes which do not belong to a pipeline cannot be designed at a later stage with the module
RF-PIPING Design.
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2.6 Graphical Display

For visual control and a clearly arranged display, it is possible to display each pipeline in a different
color. You can set this function in the Display navigator: Colors in Graphics According to →
Pipelines.

Figure 2.46: Pipelines in rendering

The functions of the graphical user interface are described in the RFEMmanual, Chapter 11.

2.7 Calculation Settings

You can modify piping-specific settings for the analysis in the Piping Analysis - Settings dialog box
(see Chapter 2.1.1, page 5). In this dialog box, the global settings for stress intensification factors,
load combinations, internal pressure and material parameters can be adjusted.

The settings for the internal pressure are checkedwith the Calculation Parameters RFEM dialog box,
Global Calculation Parameters tab: If you select, for example, the Bourdon effect for the add-on
module RF-PIPING, the check box for the RFEM analysis will be also activated.

Figure 2.47: Dialog section Pipe Internal Pressure in the dialog box Calculation Parameters

The Bourdon effect is only fully considered for members of the type Piping: Regular members
are only subject to elongation, the curvatures are considered additionally for pipelines (option
Elongation and straightening).
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2.8 Results

You have the same possibilities for the results display and evaluation in RF-PIPING as for normal
load cases and combinations. They are described in the RFEMmanual, Chapter 8 and 9.

Figure 2.48: Axial forces of RF-PIPING load case with display mode Cross-Sections

You can include the results in the printout report (see Chapter 4, page 62).
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3 RF-PIPINGDesign
The add-on module RF-PIPING Design is a tool for piping analysis according to the standards
ASME B31.1 [1], ASME B31.3 [2] and DIN EN 13480-3 [3] (in preparation). The stress designs due to
permanent and occasional loads and from thermal expansion are carried out.

RF-PIPING Design is integrated in RFEM. Thus, the design-relevant input data is already preset
when you start the module. After the design, you can use the graphical RFEM user interface to
evaluate the results. You can include the designs in the printout report.

3.1 Start RF-PIPING Design

In RFEM, you have the following possibilities to start the add-on module RF-PIPING Design.

Menu
You can open the add-on module with the RFEMmenu

Add-onModules → Piping → RF-PIPING Design.

Figure 3.1: Menu Add-onModules→ Piping→ RF-PIPING Design
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Navigator
Alternatively, you can open the add-on module in the Data Navigator by clicking

Add-onModules → RF-PIPING Design.

Figure 3.2: Data Navigator Add-onModules→ RF-PIPING Design

3.2 Input Data

When you start the add-on module, a new window is displayed. A navigator is displayed on the
left, managing the currently available tables. The drop-down list above the navigator contains the
design cases (see Chapter 3.7.1, page 59).

The design-relevant data is stored in three tables. When you open RF-PIPING for the first time, the
following parameters are imported automatically:

• Pipelines

• Piping Combinations (PC) and Piping Result Combinations (RC)

• Materials

• Cross-Sections

To select a table, click the corresponding entry in the navigator. To set the previous or next table,
use the buttons shown on the left. Alternatively, you can use the function keys to go to the next
[F2] or previous [F3] table.

To save the results, click [OK]. You exit RF-PIPING Design and return to RFEM. To exit the add-on
module without saving the data, click [Cancel].
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3.2.1 General Data

In Table 1.1 General Data, you select the pipelines and combinations that you want to design. The
standard is already preset due to the default setting for RF-PIPING (see Chapter 2.1.1, page 5).

Figure 3.3: Table 1.1 General Data

Design
It is only possible to design Pipelines. Single piping components which are not assigned to a
pipeline are not available.

If you want to analyze only selected pipelines, clear the check box All: Then you can access the
text box to enter the numbers of the relevant pipelines. Use the [Delete] button to clear the
list of preset numbers in the box. By using the [Select] button, you can also select the pipelines
graphically in the RFEM work window.

Standard/ National Annex (NA)
In this dialog section, the design is displayed which is preset in the General Data RFEM dialog box
for the calculation with RF-PIPING (see Figure 2.3, page 5). You have the following opportunities:

• ASME B31.1-2012 [1]

• ASME B31.3-2012 [2]

• EN 13480-3:2013 [3] (in preparation)
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Select Load Case
The column Existing Load Combinations lists all piping combinations PC and result combinations
RC that have been created in RFEM.

Use the button to transfer selected entries to the list Selected for Piping Design on the right.
Alternatively, you can double-click the entries. To transfer the complete list to the right, use the
button .

To transfer multiple entries of combinations, click the entries while pressing the [Ctrl] key as
common for Windows applications. Thus, you can transfer several combinations at the same time.

If the number of a combination is displayed in red, such as RC 6 in Figure 3.3, you cannot design
it: This happens when a combination is defined without any load data. When you transfer such a
load case, a corresponding warning appears.

At the end of the list, several filter options are available. They will help you assign the entries
sorted according to certain criteria.

Figure 3.4: Filter options for combinations

The buttons have the following functions:

All combinations in the list are selected.

The selection of the combinations is inverted.

Table 3.1: Button in the tab Load Combination Selection

The column Selected for Piping Design lists all piping combinations and result combinations that
have been selected for design. Click or double-click to remove selected entries from the list.
The button empties the whole list.

Comment
In this text box, you can type user-defined notes describing, for example, the current design case.
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3.2.2 Materials

This table is split into two parts. The upper part lists all materials created in RFEM. In theMaterial
Properties section, the properties of the current material, e.g. the table row currently selected in
the upper section, are displayed.

Figure 3.5: Table 1.2Materials

Materials that won't be used in the design appear in gray lettering. Materials that are not allowed
are highlighted red, modified materials are displayed in blue.

The material properties required for the determination of internal forces (Main Properties) are
described in Chapter 4.3 of the RFEM manual. The material properties required for design are
stored in the global material library. These values are preset (Additional Properties).

To adjust the units and decimal places of material properties and stresses, select Settings→Units
and Decimal Places (see Chapter 3.7.2, page 60).

Material Description
The materials defined in RFEM are already preset, but it is always possible to modify them: To
activate the field, click the material in column A. Then click the button or press function key [F7]
to open the material list.

Figure 3.6: List of materials

In compliance with the design concept, you can select only piping materials.
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Material Library
Numerous materials are already available in the library. To open the library, select

Edit → Material Library

or use the button shown on the left.

The material library is described in Chapter 2.2.1.3 on page 13.

3.2.3 Cross-Sections

This table lists the cross-sections that are used for the design.

Figure 3.7: Table 1.3 Cross-Sections

Cross-Section Description
The cross-sections defined in RFEM are preset together with the assigned material numbers.

If you want to modify a cross-section, click the entry in column B to activate this field. Click
[Cross-Section Library] or in the field or press function key [F7] to open the dialog box Edit Piping
Cross-Section (see Figure 2.10, page 12).

Modifying the cross-section also affects the model in RFEM!

Max. Design Ratio
This columnwill be shown after the calculation. It serves as a decision support for the optimization:
By means of the design ratios and colored relation scales, you can see which piping cross-sections
are little utilized and thus oversized, or overloaded and thus undersized.
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Remark
This column shows remarks in the form of footers that are described in detail below the cross-sec-
tion list.

Info About Cross-Section
In the Info About Cross-Section dialog box, you can view the cross-section properties, stress points,
and c/t-parts.

Figure 3.8: Dialog box Info About Cross-Section

The buttons below the cross-section graphic have the following functions:

Button Function

Displays or hides the stress points

Displays or hides the c/t-parts

Displays or hides the numbers of stress points or c/t-parts

Displays the details of the stress points or c/t-parts

Displays or hides the dimensions of the cross-section

Displays or hides the main axes of the cross-section

Resets the full view of the cross-section graphic

Prints the cross-sections properties and graphic

Table 3.2: Buttons of the cross-section graphic
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3.3 Calculation

3.3.1 Detail Settings

Before starting the calculation, you should check the design details. To open the corresponding
dialog box, use the [Details] button available in every window of the add-on module. The content
of this dialog box varies depending on the design standard. The following description refers to
the detail settings for ASME B31.1 [1].

The Details dialog box contains the following tabs:

• Details

• Used Literature

Figure 3.9: Dialog box Details, tab Details

Stresses
The limit stresses based on the designs may vary. They are, amongst other things, dependent on
two parameters which you can define manually in this dialog section:

• Number of thermal cycles N according to [1] sec. 102.3.2

• Occasional load factor k according to [1] sec. 104.8.2
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Display Result Tables
In this dialog section, you can select the result tables including parts list that you want to display.
These tables are described in Chapter 3.4 from page 46.

3.3.2 Starting Calculation

To start the calculation, click the [Calculation] button that is available in all input tables of the
RF-PIPING Design add-on module.

RF-PIPING Design searches for the results of the piping combinations and result combinations se-
lected for design. If no results can be found, the program starts the RFEM calculation to determine
the design-relevant internal forces.

You can also start the calculation in the RFEM user interface: The To calculate dialog box (menu
Calculation→ To Calculate) includes, amongst other things, design cases of the add-onmodules.

Figure 3.10: Dialog box To Calculate

If the RF-PIPING Design cases are missing in the Not Calculated list, select All or Add-onModules in
the drop-down list at the end of the dialog section.

To transfer the selected RF-PIPING Design cases to the section on the right, click . Click [OK] to
start the calculation.

Subsequently, you can observe the design process in a separate dialog box.
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3.4 Results

Immediately after the calculation, the Table 2.1 Design by Load Combination is displayed.

Figure 3.11: Result table with designs and details

The designs are sorted in the result tables 2.1 to 2.5 by different criteria. The Tables 3.1 and 3.2
display the governing internal forces, the Table 4.2 displays the parts list.

Each table can be selected by clicking the corresponding entry in the navigator. To go to the
previous or next table, use the buttons shown on the left. Alternatively, you can use the function
keys to select the next [F2] or previous [F3] table.

Click [OK] to save the results. You exit RF-PIPING Design and return to RFEM.

The buttons below the table have the following functions:

Button Description Function

Color bar
Displays or hides the colored reference scales in the result
tables

Filter parameters
Represents the criterion for filtering the results in tables:
Design ratios greater than 1, maximum value, or user-defined
limit

Apply filter
Shows only rows where the filter parameters are valid (ratio >
1, maximum, user-defined value)

Result diagrams
Opens the dialog box Result Diagram onMember
→ Chapter 3.5.2, page 57

Member selection
Allows for the graphical selection of a member to display its
results in the table

Viewmode Goes to the RFEM work window for changing the view

Table 3.3: Buttons in the result tables 2.1 to 2.5
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3.4.1 Design by Load Combination

The upper part of the table shows a summary of the governing checks sorted by piping combina-
tions and result combinations.

The lower part provides detailed information about the cross-section properties, design internal
forces, and check parameters for the combination selected above.

Figure 3.12: Table 2.1 Design by Load Combination

Description
This column shows the descriptions of the piping and result combinations used for the designs.

Member No.
This column shows the number of the member with the maximum design ratio of the analyzed
action.

Location
This column shows the respective x-location where the member's maximum stress ratio occurs.
For the table output, the program uses the following member locations x:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (Calculation Parameters RFEM
dialog box, Global Calculation Parameters tab)

• Extreme values of internal forces
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Design Ratio
Columns D and E display the design conditions with the ratios which result from the design
according to the set standard.

The length of the color scale displays graphically the respective ratio.

Design According to Formula
This column displays more information about the performed design.

3.4.2 Design by Cross-Section

Figure 3.13: Table 2.2 Design by Cross-Section

This table shows themaximumdesign ratios of all pipelines selected for design, sorted by cross-sec-
tion.

TheMember No. column shows the number of the member with the maximum design ratio for
the individual design criteria.
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3.4.3 Design by Pipeline

Figure 3.14: Table 2.3 Design by Pipeline

This result table lists the maximum design ratios sorted by pipelines.

3.4.4 Design byMember

Figure 3.15: Table 2.4 Design byMember

The maximum design ratios are displayed sorted by member number.
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3.4.5 Design by x-Location

Figure 3.16: Table 2.5 Design by x-Location

This result table lists the maxima for each member at any locations x resulting from the division
points in RFEM:

• Start and end node

• Division points according to possibly defined member division (see RFEM Table 1.16)

• Member division according to specification for member results (RFEM dialog box Calculation
Parameters, tab Global Calculation Parameters)

• Extreme values of internal forces
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3.4.6 Governing Internal Forces byMember

Figure 3.17: Table 3.1 Governing Internal Forces byMember

This table shows for eachmember the governing internal forces - those internal forces which result
in maximum design ratios at the individual designs.

Location x
This column shows the respective x-location where the member's maximum stress ratio occurs.

Loading
This columndisplays thenumber of thepipingor result combinationwhose internal forcesproduce
the maximum design ratio.

Forces / Moments
For each member, this column displays the axial and shear forces as well as the torsional and
bending moments producing the maximum design ratio in the respective designs.

Design According to Formula
The final column provides information on the type of design and the formulas used in the designs
according to the specified standard.
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3.4.7 Governing Internal Forces by Pipeline

Figure 3.18: Table 3.2 Governing Internal Forces by Pipeline

This table shows the internal forces of each pipeline which result in the maximum design ratios
for the individual designs.



3 RF-PIPING Design

©DLUBAL SOFTWARE 2016

53

3
3.4.8 Parts List by Pipeline

Finally, RF-PIPING Design provides a summary of all cross-sections that are included in the design
case.

Figure 3.19: Table 4.1 Parts List by Pipeline

By default, this list contains only the designed pipelines. If you need a parts list for all pipelines of
the model, select the corresponding option in the Details dialog box (see Figure 3.9, page 44).

Part No.
The program automatically assigns part numbers to similar pipelines.

Pipeline Description
This column shows the pipeline descriptions.

Number of Pipelines
This column shows for each part howmany similar pipelines exist.

Length
This column displays the length of a single pipeline.

Total Length
The values in this column are the product from the previous two columns.
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Surface Area
For each part, the program indicates the surface areas relative to the total length. They are deter-
mined from the surface area of the cross-sections that can be viewed in the Tables 1.3 and 2.1 to
2.5 in the cross-section properties (see Figure 3.8, page 43).

Volume
The volume of a part is determined from the cross-sectional area and the total length.

Unit Weight
The unit weight is the weight of the section relative to the length of one meter.

Weight
The values of this column are determined from the respective product of the entries in column C
and G.

Total Weight
The final column indicates the total weight of each part.

Sum
At the bottom of the list, you find a summary of the values in columns B, D, E, F, and I. The last row
of the Total Weight column informs you about the total amount of required steel.

3.5 Evaluation of Results

You can evaluate the design results in different ways. The buttons in the Tables 2.1 to 2.5 may
help you to evaluate the results. You can find them below the upper table.

Figure 3.20: Buttons for evaluation of results

The functions of the buttons are described in Table 3.3 on page 46.
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3.5.1 Results on RFEMModel

You can also evaluate the design results in the RFEM work window.

RFEM Background Graphic and ViewMode
The RFEM graphic in the background may be useful when you want to check the position of a
particular pipeline in the model: The member selected in the RF-PIPING Design result table is
highlighted in color in the background graphic. Furthermore, an arrow indicates the member's
x-location displayed in the currently selected table row.

Figure 3.21: Indication of the member and the current Location x in the RFEMmodel

If you cannot improve the display by moving the module window, click [Jump to Graphic] to
activate the ViewMode: The program hides themodule window so that you canmodify the display
in the RFEM user interface. In the view mode, you can use the functions of the Viewmenu, for
example zooming, moving, or rotating the display. The indication arrow remains visible.

Click [Back] to return to the add-on module RF-PIPING Design.

RFEMWorkWindow
The design ratios can also be checked graphically in the RFEMmodel: Click the [Graphics] button
to exit the design module. In the RFEM work window, the design ratios are now displayed, such
as the internal forces of a load case.

To display or hide design results, use the [Show Results] button known from the display of internal
forces. To display the result values, click the [Show Result Values] button in the toolbar to the
right.

To set the design cases (see Chapter 3.7.1, page 59), you can use the list in the RFEMmenu bar.

To adjust the results display, use the Display navigator below the entry Results → Members. The
display of the design ratios is Two-Colored by default.
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Figure 3.22: Display Navigator: Results→Members

When you select a multicolor representation (optionsWith/Without Diagram or Cross-Sections), the
color scale panel becomes available. It provides the common control functions described in the
RFEMmanual, Chapter 3.4.6.

Figure 3.23: Design ratios with display option Cross-Sections

To return to the add-on module, click [RF-PIPING Design] in the panel.
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3.5.2 Result Diagrams

You can also graphically evaluate a member's result distributions in a result diagram.

Select themember in the RF-PIPING Design result table by clicking in the table row of themember.
Then, open the Result Diagram onMember dialog box by clicking the button shown on the left.
You can find the button below the upper result table (see Figure 3.20, page 54).

To display the result diagrams in the RFEM graphic, select in the menu

Results → Result Diagrams for SelectedMembers

or use the corresponding button in the RFEM toolbar.

A window opens, graphically presenting the distribution of the maximum design ratios on the
member.

Figure 3.24: Dialog box Result Diagram onMember

Use the list in the toolbar to choose the relevant RF-PIPING Design design case (see Chapter 3.7.1,
page 59).

The Result Diagram onMember dialog box is described in the RFEMmanual, Chapter 9.5.
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3.6 Filter for Results

The RF-PIPING Design result tables allow you to sort the results by various criteria. In addition, you
can filter options for the tables (see Figure 3.20, page 54) to limit the numerical output by design
ratios. This function is described in the following article of the DLUBAL Blog:
https://www.dlubal.com/blog/11217

Furthermore, you can use the filter options described in Chapter 9.9 of the RFEMmanual in order
to evaluate the results graphically.

In RF-PIPINGDesign, you can also use the Visibility option to filter themembers in order to evaluate
them (see RFEMmanual, Chapter 9.9.1).

Filtering Designs
The design ratios can easily be used as filter criteria in the RFEM work window which you can
access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If the panel
is not active, select in the RFEMmenu

View → Control Panel (Colour scale → Factors → Filter)

or use the toolbar button shown on the left.

You define the filter settings for the results in the first panel tab (Color spectrum). Because this tab
is not available for the two-colored results display, you have to use the Display navigator and set
the display optionsWith/Without Diagram or Cross-Sections first (see Figure 3.22, page 56).

The panel is described in the RFEMmanual, Chapter 3.4.6. In Chapter 9.9.3, you can find detailed
information about filter options for result values.

FilteringMembers
In the Filter tab of the control panel, you can specify the numbers of particular members to display
only those results. This function is described in the RFEMmanual, Chapter 9.9.3.

Figure 3.25: Member filter for the design ratios of a pipeline

Unlike the partial view function (Visibilities), the graphic displays the entire pipeline model. The
figure above shows the design ratios of a pipeline. The remaining pipelines are displayed in the
model, but are shown without design ratios.
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3.7 General Functions

3.7.1 Design Cases

Design cases allow you to group pipelines for a design or analyze members with particular design
specifications. It is no problem to analyze the same pipeline in different design cases.

To calculate a design case, you can also use the load case list in the RFEM toolbar.

Create NewDesign Case
To create a new design case, use the RF-PIPING Design menu and click

File → New Case.

Figure 3.26: Dialog box New RF-PIPING Design Case

In this dialog box, enter a No. (one that is still available) for the new design case. An appropriate
Descriptionwill make the selection in the load case list easier.

When you click [OK], Table 1.1 General Data opens where you can enter the new design data.

Rename Design Case
To change the description of a design case, use the RF-PIPING Design menu and click

File → Rename Case.

Copy Design Case
To copy the input data of the current design case, use the RF-PIPING Design menu and click

File → Copy Case.

Delete Design Case
To delete design cases, use the RF-PIPING Design menu and click

File → Delete Case.

Figure 3.27: Dialog box Delete Cases

You can select the relevant design case in the list of Available Cases. To delete the selected case,
click [OK].
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3.7.2 Units and Decimal Places

Units and decimal places for RFEM and the add-on modules are managed in one dialog box. In
RF-PIPING Design, you can use the menu to adjust the units. To open the corresponding dialog
box, click

Settings → Units and Decimal Places.

The following dialog box appears which you already know from RFEM. RF-PIPING Design is preset
in the Program /Module list.

Figure 3.28: Dialog box Units and Decimal Places

You can save the settings as a user profile to reuse them in other models. These functions are
described in Chapter 11.1.3 of the RFEMmanual.

3.7.3 Data Transfer

3.7.3.1 ExportingMaterials to RFEM

If you adjust the materials in RF-PIPING Design for design, you can export the modified materials
to RFEM: To do this, go to the Table 1.2 Materials, and then select the command in the menu

Edit → Export All Materials to RFEM.

Alternatively, you can export the modified materials to RFEM by using the shortcut menu in Table
1.2.

Figure 3.29: Shortcut menu of Table 1.2 Materials
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Before the modified materials are transferred to RFEM, a query appears as to whether you want to
delete the results in RFEM. By confirming the query and starting the [Calculation] in the RF-PIPING
Design module, the RFEM internal forces as well as the design ratios will be determined in a single
calculation run.

If the modified materials have not been exported to RFEM yet, you can reimport the original
materials in the design module by using the options shown in Figure 3.29. Please note that this
option is only available in Table 1.2 Materials.

3.7.3.2 Exporting Results

You can use the RF-PIPING Design results also in other programs.

Clipboard
To copy cells selected in the result tables to the Clipboard, use the keys [Ctrl]+[C]. Press [Ctrl]+[V]
to insert the cells, for example in a word processing program. The headers of the table columns
will not be transferred.

Printout Report
You can print the data of RF-PIPING Design into the printout report (see Chapter 4.1, page 62). To
export them, click

File → Export to RTF.

The function is described in the RFEMmanual, Chapter 10.1.11.

Excel / OpenOffice
RF-PIPING Design provides a function for the direct data export to MS Excel, OpenOffice Calc or
the file format CSV. To open the corresponding dialog box, select in the module menu

File → Export Tables.

The following export dialog box appears:

Figure 3.30: Dialog box Export - Export of Tables

When you have selected the relevant options, you can start the export by clicking [OK]. Excel or
OpenOffice will be started automatically, you do not need to open the programs first.
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4 Printout

4.1 Printout Report

Like in RFEM, the program generates a printout report for the RF-PIPING Design results, to which
you can add graphics and descriptions. The selection in the printout report determines which
data from the add-on modules will be included in the final printout.

The printout report is described in the RFEMmanual. Chapter 10.1.3 Define Contents of Printout
Report explains how to prepare the input and output data for the printout.

Figure 4.1: Printout Report for RF-PIPING and RF-PIPING Design

For large piping structures, it is recommended to split the data into several printout reports, thus
allowing for a clearly-arranged printout.



4 Printout

©DLUBAL SOFTWARE 2016

63

4

4.2 Graphic Printout

In RFEM, you can add every picture displayed in the work window to the printout report or send it
directly to a printer. In this way, you can also prepare the internal forces, deformations or design
ratios displayed on the RFEMmodel for the printout.

To print the currently displayed graphic click

File → Print Graphic

or use the toolbar button shown on the left.

Also in the Result Diagram dialog box (see Figure 3.24, page 57), you can use the button to
transfer the graphic of internal forces, deformations or design ratios to the printout report or print
it directly.

The following dialog box appears:

Figure 4.2: Dialog box Graphic Printout

Printing graphics is described in the RFEMmanual, Chapter 10.2. In this chapter, the other tabs of
the Graphic Printout dialog box are explained.
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Figure 4.3: Printout report with pipeline graphic

To move a graphic within the printout report, use the drag-and-drop function. To adjust a graphic
in the printout report at a later time, right-click the corresponding entry in the navigator of the
printout report. The Properties option in the shortcut menu opens the Graphic Printout dialog box,
offering various options for adjustment.
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